
Stage spectroscopie à l’OHP 
D. Katz (david.katz@obspm.fr – 01 45 07 78 45) 
 
Recommandation pour les lecteurs pressés : si vous ne devez lire quʼun paragraphe, lisez les 
consignes de sécurité !!!. 
 
Attention : lʼessentiel du texte a été rédigé de mémoire (et le soutien de quelques notes) à 
Meudon. Des inexactitudes on pu sʼimmiscer dans la description des instruments ou des 
commandes du spectrographe, etc... 
 

1 Présentation et objectifs du stage : 
 
Voici une brève présentation du stage de spectroscopie à lʼOHP des étudiants de M2 filière DSG. 
Le stage comprend 5 nuits dʼobservation. Les étudiants sont répartis en groupe de 3 à 4 sur 3 
télescopes : 80, 120 et 152. Chaque soir, les groupes permutent. En cas de beau temps, chaque 
groupe passe un peu plus de 1.5 nuits par télescope. La spectroscopie se déroule sur le 
télescope de 152 cm avec le spectrographe Aurélie. 

Les objectifs du volet spectroscopie du stage sont de familiariser les étudiants avec: 
 
 1. Les observations astronomiques : choix des sources, pointage du télescope, etc... 
 2.     Les observations spectroscopiques: instrument, concepts de spectroscopie (dispersion, 
résolution, etc...), interface utilisateur, calibrations, logiciels de réduction et dʼanalyse 
(MIDAS), etc... 
 3. La spectroscopie stellaire : morphologie des spectres stellaires en fonction des paramètres 
atmosphériques, mécanismes de formation des raies, etc... 
 4. Autres (suivant météorologie) : rotation des planètes géantes, redshift dʼun quasar (3C273), 
étoiles binaires courte période, identification dʼétoiles dʼamas via leurs vitesse radiale, etc... 
Les 3 premiers points sont traités durant la première nuit dʼobservation. Si la météo le permet, la 
deuxième nuit permet de traiter certains aspects du point 4. 
 
2 Première nuit d’observation 
 
2.1 Chronologie 
La première nuit suit la chronologie suivante : • Présentation du télescope • Présentation du 
spectrographe Aurélie• Présentation de la salle de contrôle • Mise en œuvre du TP de 
spectroscopie stellaire 
 
2.2 Le télescope 
La salle du télescope comprend deux parties : • La partie basse où se trouve la console de 
pointage du télescope (plus ouverture de la trappe 
de la coupole, rotation de la coupole, etc...). La partie basse comprend un plancher mobile 
que lʼon peut monter si besoin pour accéder au chercheur pour le pointage fin du télescope. •
 Une galerie (partie haute), qui permet notamment dʼaccéder au chercheur pour le pointage 
fin du télescope. 
A partir de la galerie, on présente aux étudiants le télescope et parcours de la lumière : miroir 
primaire, miroir secondaire, miroir coudé, puis via lʼaxe du télescope jusquʼau spectrographe qui 
se trouve dans la salle de contrôle. 
A partir de la partie basse, on explique le pointage du télescope. Cʼest également le moment de 
présenter les consignes de sécurité aux étudiants (voir ci‐dessous). Le pointage sʼeffectue en 
trois temps : 



• Les mouvements rapides. Ils sont commandés à partir de la console de pointage en partie 
basse. Deux cadrans permettent de lire lʼascension droite et la déclinaison que pointe le 
télescope. Deux grosses molettes permettent de faire varier les coordonnées de pointage. Ces 
molettes permettent de mettre le télescope en mouvement (plus ou moins rapide) et de lʼarrêter, 
mais ne définisse pas le sens du mouvement. Ce sont deux petits boutons qui définissent si lʼon 
va vers les alpha (respectivement delta) croissants ou décroissants. Attention à ne pas forcer les 
molettes au‐delà du point dʼarrêt du télescope. Cʼest un réflexe « classique », que peuvent avoir 
les étudiants quand ils dépassent les coordonnées de pointage et quʼils désirent revenir en 
arrière. Il ne faut surtout pas le faire car la conséquence est de casser lʼaxe en graphite de la 
molette et de perdre le contrôle du télescope (auquel cas, il faut appuyer sur le bouton rouge 
dʼarrêt dʼurgence). On peut affiner une première fois le pointage avec les boutons de 
mouvements lents qui se trouvent sous les cadrans. 
 
• On utilise ensuite le chercheur (petit télescope situé le long du télescope de 152) pour 
positionner lʼimage de lʼétoile au plus près du trou dʼentrée du spectrographe. Le trou dʼentrée est 
légèrement excentré par rapport au champ du chercheur. En général un dessein scotché sur la 
console montre où positionner lʼétoile dans le champ du chercheur. Cette position peut varier. En 
Mars 2011, il fallait positionner lʼétoile « 2 graduations » à droite et « 2 graduations » vers le bas 
par rapport au centre du champ (une graduation est définie par le carré formé par les croisillons 
au centre du champ). Une raquette permet de contrôler le télescope pendant que lʼon affine le 
pointage au chercheur (appuyer simultanément sur le bouton rouge à lʼarrière pour accélérer les 
mouvements). 
 
• La dernière étape se déroule dans la salle de contrôle du spectrographe. Une petite télévision 
permet de visualiser la lumière qui nʼentre pas dans le spectrographe. Une croix sur lʼécran 
matérialise le trou dʼentrée du spectrographe. A lʼaide dʼune raquette, on « déplace lʼétoile » sur 
la croix (appuyer simultanément sur le bouton rouge à lʼarrière pour accélérer les mouvements). 
Une fois lʼétoile correctement positionné on peut lancer le guidage automatique du télescope en 
appuyant sur la touche G de la console grise se trouvant en bas à gauche par rapport à la 
télévision. La coupole ne suit pas les mouvements du télescope. Durant les poses longues, il faut 
aller tourner la coupole (une fois ou plus suivant la durée de la pose) pour éviter de pointer la 
coupole plutôt que la trappe. 
 
Consignes de sécurité :  
 
• Durant ses mouvements rapides, le télescope peut heurter (i) le pilier nord et (ii) la rambarde de 
sécurité si lʼon pointe vers le bas. La personne manipulant le télescope à la console 
(mouvements rapides) doit toujours également garder un œil sur le télescope. 
• Durant les mouvements du télescope, le petit télescope servant de chercheur ne peut pas 
heurter la rambarde de sécurité. En revanche, dans certaines directions de pointage, lʼespace 
entre le chercheur et la rambarde est de lʼordre du centimètre. Il nʼy a pas la place pour la tête ou 
le bras dʼun observateur. En conséquence, quand des mouvements rapides du télescope sont 
effectués, il ne doit y avoir aucun observateur en haut. En particulier, quand une erreur de 
pointage nécessitant des mouvements rapides est constatée alors quʼun observateur est au 
chercheur, ce dernier doit redescendre dans la partie basse avant que le moindre mouvement 
rapide soit effectué. 
• Lors de certains mouvements du télescope, le contrepoids passe à coté de la console de 
contrôle du télescope. Les personnes présentes doivent garder un œil sur le contrepoids. • En 
cas de problème, il y a un gros bouton rouge dʼarrêt dʼurgence à droite de la console de pointage 
du télescope.  
• Il doit toujours y avoir un encadrant sous la coupole avec les étudiants durant le pointage 
du télescope pour sʼassurer du bon respect des règles ci‐dessus. 
 
2.3 Le spectrographe Aurélie 
Le spectrographe Aurélie se trouve dans la salle de contrôle du spectrographe derrière le drap 



noir. Avec lʼaccord de lʼassistant de nuit, on peut ouvrir la trappe à lʼarrière pour montrer une 
partie du chemin optique. La lumière est dispersée par un réseau en réflexion. On a le choix entre 
plusieurs réseaux suivant la résolution spectrale que lʼon désire (voir page web Aurélie pour tous 
les détails). Le CCD est refroidi a ‐110°C (si ma mémoire est juste). Un afficheur digital permet de 
vérifier que le CCD est bien à la bonne température. 
 
A lʼentrée du spectrographe, un découpeur dʼimage (« image slicer ») permet de découper la PSF 
circulaire en 5 « bouts » et de les projeter en ligne les uns au dessus des autres sur la fente du 
spectrographe. Cʼest ce dispositif qui fait que lʼimage du spectre sur le CCD est constituée de 5 
bandes parallèles sʼétendant au total sur environ 80 pixels de large. Le spectrographe nʼétant 
isolé du reste de la salle que par un drap, on baisse en général la lumière quand on commence 
les observations. Le spectrographe Aurélie et son environnement logiciel sont parfaits pour 
lʼenseignement.  
TBD : A DETAILLER. 
 
2.4 La salle de contrôle du spectrographe 
Outre le spectrographe, la salle comprend dans sa partie Est, trois ordinateurs. En allant de la 
gauche vers la droite quand on est face au mur Est : 
• Le premier ordinateur collecte les images du CCD. MIDAS est installé sur lʼordinateur. Les 
commandes de base ainsi que plusieurs procédures OHP permettent dʼeffectuer de nombreuses 
réductions et mesures au fur et à mesure des observations. 
• Le second ordinateur commande le spectrographe : choix de la longueur dʼonde centrale, 
mise au point, poses de calibrations, pose sur les objets, etc... 
• Le troisième ordinateur permet dʼaccéder à internet pour obtenir des cartes de champs (en 
cas dʼambiguïté sur lʼobjet pointé), pour choisir les cibles dans les catalogues du CDS, etc... 
Le spectrographe se commande via une fenêtre contenant plusieurs menus. En allant dans le 
menu « conduite des poses » (libellé exact à confirmer) puis dans « pose dʼun seul type » (libellé 
exact à confirmer » on peut choisir de lancer des poses de calibration (offset, flat‐field, 
Thorium‐Argon pour la calibration en longueur dʼonde, dark en général négligeable) ou une pose 
sur le ciel. En général il suffit de renseigner le temps de pose désiré, la densité que lʼon désire 
insérer dans le faisceau pour lʼatténuer (pour les poses de calibration), le nom de lʼobjet, le 
nombre de pose. 
TBD : A COMPLETER. 
Lʼordinateur recevant les observations permet de les visualiser et de les traiter. On peut avoir 
besoin de changer/retrouver le répertoire contenant les images des spectres. Ces images sont 
stockées dans /vol3/images/ 

2.5 Le TP 
Lʼobjectif scientifique du TP est que les étudiants : 
 
 • observent comment la morphologie des spectres évolue avec les paramètres atmosphériques : 
température effective, logarithme de la gravité de surface, métallicité.  
• Quʼils déduisent (eux‐mêmes!☺) de ces observations des critères visuels permettant de 
déterminer ces paramètres.  
• discuter avec eux des mécanismes physiques qui sous‐tendent les critères visuels. En guidant 
un peu les étudiants de M2, ils arrivent à trouver une (grande) partie des explications par eux-
mêmes.  
• On peut conclure par un « jeu » : lʼencadrant choisi des étoiles et les étudiants les observe et 
doivent deviner lʼordre de grandeur de leurs paramètres atmosphériques.Le réseau utilisé pour ce 
TP est le réseau numéro 3 qui offre une résolution R = 10 000 (dans le domaine spectral 
considéré). On utilise le domaine spectral 4800 à 5200 angströms. Ce domaine contient 
notamment la raie Hbeta (4861.323 A, série de Balmer de lʼhydrogène), le triplet vert du 
magnésium et de fortes bandes moléculaires dans les étoiles froides. 
 
 



 
 
Pour réaliser avec brio ce TP, les étudiants vont :  
• Choisir leurs cibles. Ils peuvent pour cela utiliser le catalogue Pastel (Soubiran et al.) 
disponible via Vizier au CDS. Ce catalogue permet de faire des requêtes à la fois sur les 
coordonnées, la magnitude et les paramètres atmosphériques. Il est bien sur recommander de 
faire des « séries » en ne faisant varier quʼun paramètre à la fois. 
•  Les observer en pointant le télescope et en lançant les poses du spectrographe. 
 • Réduire les spectres. 
 • Examiner les séries de spectres pour en déduire des critères visuels de classification 
stellaire. 
 
Pour ne pas perdre de temps en début de nuit, on peut choisir la (les 2) première(s) cible(s) pour 
les étudiants. Une étoile de type solaire de magnitude comprise entre 5 et 7 permettra un 
démarrage rapide et offrira un point de départ « intéressant ». 
 
Critères pour une classification spectrale « à lʼœil » :  
Température : 

• Présence de bandes moléculaires très forte dans les étoiles « très froides », moins de ~4 
000 K. Les molécules sont assez fragiles et se dissocient en atomes quand on monte 
en température. Les bandes moléculaires dominent donc les spectres des étoiles 
froides. A plus haute température, elles sont progressivement « noyées » dans les 
raies atomiques. Finalement les molécules sont complètement dissociées. 

 
• De ~5 000 K à ~8 000 K, les ailes de la raie Hbeta deviennent de plus en plus large. Ceci 

est du (entre autre) à lʼeffet Stark, des collisions (i.e. rencontres proches modifiant les 
niveaux dʼénergie) entre atomes dʼHydrogènes et ions. 

 
• Les raies des atomes neutres (qui dominent à basse température) deviennent de moins en 

moins intenses (nombreuses) quand on monte en température. Cʼest la conséquence 
de lʼionisation progressive des éléments avec la montée en température. 

 
Gravité :  

• Les ailes des raies du triplet du magnésium sont plus larges dans les étoiles naines que 
dans les étoiles géantes. Lʼeffet nʼétant pas aussi fort que pour Hbeta, il est 
recommandé de zoomer sur le triplet et de superposer un spectre de naine et un 
spectre de géante (on pourra guider un peu les étudiants ici). Attention, les raies du 
triplet sont également sensibles à la température, à la métallicité et à lʼabondance en 
magnésium. Il faudra donc en particulier comparer deux spectres de températures et 
métallicités proches. 
 

Métallicité  
• Lʼintensité des raies décroit avec la métallicité. On voit que température et métallicité influe 

tous deux (en ce sens opposés) sur lʼintensité des raies. La raie Hbeta est un critère 
bien venu pour lever la dégénérescence. 

 
 
On peut évoquer le fait quʼil ne sʼagit là que de quelques critères pour déterminer les paramètres 
atmosphériques et quʼil en existe dʼautre. Avec des étudiants de niveau M2 ou plus, on peut 
présenter les bases de lʼanalyse détaillée : équilibre dʼexcitation, équilibre dʼionisation, etc... 
 

Observations complémentaires :  Etoiles Wolf Rayet, Etoiles Be, Nébuleuses planétaires, 
planètes, galaxie M31. 



Exercice: Réduction du spectre d'une étoile 
M. Puech  

 
ImageJ est un logiciel bien adapté pour travailler sur des images. Pour travailler sur des spectres 1D, 
nous allons utiliser le logiciel SPLAT, plus adapté. Celui-ci peut être téléchargé ici: 
http://astro.dur.ac.uk/~pdraper/splat/splat-vo/ . Un mode d'emploi (en anglais) est également 
disponible http://astro.dur.ac.uk/~pdraper/splat/sun243.htx/sun243.html 
 
Nous allons utiliser ce logiciel pour réduire les spectres d'une étoile observée au télescope de 152 cm 
de l'OHP (vous effectuerez des observations similaires pendant le stage OHP). 
 
ANCIEN Stage :  Les données brutes ainsi que les fichiers de calibration se trouvent dans le fichier
 sur sympa.obspm.fr (Documents partagés, dossier informatique/Seance1). 
 

1. Inspection des données brutes 
Ouvrez les trois fichiers correspondants aux trois spectres brutes : File > Open... et sélectionnez les 
trois fichiers à . Inspectez le header des trois fichiers en cliquant sur View > View FITS header. 
Vérifiez si le temps d'exposition des trois images est identique et calculez le temps d'exposition total. 
Le logiciel affiche une nouvelle fenêtre montrant les trois spectres superposés. Sur la fenêtre 
principale, sélectionnez le spectre correspondant au fichier en cliquant tour à tour sur les items 
Spectrum du menu de gauche. Le nom de fichier correspondant s'affiche en haut de la partie de droite 
de la même fenêtre. Sur la ligne Short Name, remplacez le nom Spectrum par quelque chose de plus 
explicite pour chacun des spectres afin de vous y retrouver et éviter que tous les fichier ne portent ne 
le même nom, par exemple : , etc. 
Cliquer sur le spectre et de-sélectionnez-le de la fenêtre d'affichage en dé- cliquant la boîte 
Displayed située en bas à droite. Cliquez maintenant sur le spectre correspondant au fichier . 
Changez sa couleur d'affichage (par exemple en rouge) en utilisant la fonction Colour disponible sur le 
partie de droite de la fenêtre principale. Ré-affichez le spectre mais en utilisant une troisième couleur 
(par exemple en vert). 
Que remarquez-vous autour du pixel 780 ? Est-ce une raie en absorption ? Zoomez sur cette région 
en utilisant le bouton central de la souris pour vous faire une idée de sa largeur. 
Fermez la fenêtre d'affichage. 

2. Construction du MASTER BIAIS 
Ouvrez les fichiers contenant les spectres de biais (10 fichiers). Les instruments modernes sont en 
général suffisamment stables pour qu'il soit suffisant de mesurer le courant de biais en début et en fin 
de nuit uniquement. Inspectez les fichiers correspondant aux mesures de début de nuit tour à tour. 
Vérifier qu'il n'y a pas dʼartefacts sur aucun des fichiers. Remplacez la ligne Short Name pour tous les 
fichiers par , etc. afin d'utiliser des noms explicites. 
Nous allons d'abord construire un biais moyen de début de nuit. Cliquez sur Operations > Simple 
maths of two spectra. Additionnez les spectres et en les sélectionnant dans les listes de gauche et 
de droite puis cliquez sur ADD. Un nouvel item apparaît dans la liste de spectres correspondant au 
résultat de cette addition. Sélectionnez-le et additionnez-lui le spectre . Répétez 
lʼopération jusqu'à que vous ayez construit la somme de tous les biais de début de nuit (attention à 
bien re-sélectionner le résultat de l'addition précédente à chaque nouvelle addition !). Fermez la 
fenêtre Simple maths of two spectra. Cliquez maintenant sur Operations > Simple maths constant. 
Sélectionnez l'addition de tous les biais de début de nuit et divisez la par le nombre de biais 
individuels. Fermez la fenêtre. 
Répétez ces opérations pour construire une biais moyen de fin de nuit. 
Affichez le biais moyen de début et de fin de nuit dans une même fenêtre avec des couleurs 
différentes et vérifier qu'il n'y a pas eu de variation notable du courant de biais pendant la nuit. Nous 
pouvons donc construire un master biais en combinant les mesures de début et de fin de nuit. Pour 
cela, additionnez les biais moyens de début et de fin de nuit et divisez le résultat par deux en vous 
inspirant des étapes précédentes. 
 



Donnez lui un Short Name explicite comme , par exemple. Affichez le master biais dans une fenêtre 
et superposez un biais individuel. Quel est le bénéfice d'avoir sommé toutes les mesures 
individuelles? Fermez la fenêtre d'affichage. La réduction est un processus mettant en jeux un nombre 
important de fichier et il est important de bien s'organiser. Une bonne règle à suivre est de fermer les 
fichiers dont nous n'avons plus besoin au fur et à mesure : sélectionnez l'ensemble des biais 
individuels et les résultats des calculs intermédiaires dans le liste des spectres de la fenêtre principale 
et appuyer sur la touche Suppr pour les enlever de la liste et ne pas risquer de les confondre avec les 
données brutes ou le Master Biais. 

3. Construction du MASTER FLAT 
Les flats ont également été mesurés en début et fin de nuit seulement car nous n'allons pas effectuer 
de mesure photométrique demandant une calibration très précise. Ouvrez les fichiers correspondants 
aux mesures de flat-field (6 fichiers). Commencez par leur donner des Short Names explicites, par 
exemple , etc. 
Inspectez les fichiers individuellement : y-a-t-il des variations entre chaque mesure et plus 
spécifiquement entre le début et la fin de la nuit ? Peut-on directement sommer les mesures de début 
et de fin de nuit ? Que remarquez-vous autour du pixel 800 ? Qu'en concluez-vous sur l'origine de ce 
pic ? 
Construisez un flat moyen à partir des mesures individuelles en vous inspirant de la manière dont 
nous avons construit le Master Biais. Affichez les valeurs de ce flat moyen en cliquant sur View > 
View/modify a spectrum, puis cherchez la valeur maximale et notez-la. Pour obtenir le master flat, 
normalisez le flat moyen en le divisant par la valeur maximale. Affichez la résultat et vérifier qu'il est 
bien normalisé à 1. Un fois le Master Flat construit, n'oubliez de lui donner un Short Name explicite, 
par exemple 
. Fermez les flats individuels et les calculs intermédiaires. 

4. Réduction des spectres individuels 
Réduisez chacun des trois spectres individuels en suivant l'équation fondamentale de la réduction. 
N'oubliez de donner des Short Names explicites aux spectres réduits, par exemple : , etc. 
Affichez dans une même fenêtre le spectre et sa version réduite. Observez comment la région autour 
du pixel 800 à été corrigée. Comparez la pente du spectre avant et après réduction. 
Fermer la fenêtre d'affichage et les spectres brutes non réduits ainsi que les calculs intermédiaires. 
5. Combinaison des spectres 
Faites la somme des trois spectres individuels réduits. Divisez le résultat par le temps d'exposition 
total. Cliquez sur View > View/modify data units. Dans la ligne Units écrire « Counts/s » et cliquez sur 
Set. La fenêtre d'affichage indique maintenant que nous avons affiché le spectre en comptes (ADU) 
par seconde. Pour une calibration plus physique, il faudrait mesurer le flux provenant d'une étoile de 
référence appelée « étoile standard » et la comparer à son flux théorique pour en déduire un facteur 
de conversion et passer en unités physiques de type erg/s/cm2/A. 
Fermez la fenêtre d'affichage et les spectres individuels réduits. 
6. Calibration en longueur d'onde 
Il reste à calibrer l'axe des abscisses pour transformer les pixels en longueurs d'onde. Pour cela, deux 
spectres d'une lampe au Thorium ont été mesurés avec le même instrument juste avant les 
observations de l'étoile. Ouvrir ces deux spectres (fichiers et ) et donnez-leurs des Short Names 
explicites, par exemple et . Comparez les deux spectres et vérifiez qu'ils sont identiques (on a 
doublé la mesure au cas où l'une des deux serait défectueuse). 
La calibration en longueur d'onde consiste à comparer la position de deux raies (de préférences 
brillantes) dans un des spectres de Thorium réalisés juste avant les poses scientifiques avec un 
spectre de référence de la même lampe mais dont la calibration en longueur d'onde est déjà très bien 
connue. Ouvrez (par exemple avec le logiciel GIMP) le fichier et repérez dans le spectre mesuré 
deux raies, de préférence aux deux extrémités du spectre (aidez-vous des groupes de raies pour ne 
pas vous tromper !). Relever leurs positions en pixels sur le spectre mesuré et en longueurs d'onde 
sur le spectre de référence. En déduire la dispersion par pixel du spectrographe en Å/pix. A partir de 
la position d'une des raies que vous avez choisie, en déduire la longueur d'onde correspondant au 
premier pixel du spectre réduit. Dans la réalité, cette procédure se fait de manière automatique en 
utilisant l'ensemble des raies de référence, ce qui conduit à une calibration beaucoup plus précise. 
Pour appliquer la calibration en longueur d'onde au spectre réduit, cliquez sur View > View/modify 
spectra values. Dans la fenêtre qui s'affiche, dé-sélectionnez la case Readonly puis cliquez sur 



Operations > Modify coordinates. Dans la nouvelle fenêtre, vérifiez que vous êtes bien sous l'onglet 
Linear et que Transform coordinates est bien sélectionné. Entrez sur la ligne Scale Factor la 
dispersion que vous avez calculé en Å /pix (vous devriez trouver quelque chose comme 0.2314 Å/pix), 
et dans la ligne Offset la longueur d'onde du premier pixel que vous avez également calculé (quelque 
chose comme 4760 Å). Cliquez sur Apply et fermez les deux fenêtres. Dans la fenêtre principale, 
cliquez sur View > View/Modify spectral coordinates. Dans la nouvelle fenêtre qui s'affiche, 
sélectionnez sur la ligne Units les unités en Angstroms (Å) puis cliquez sur Set et fermez la fenêtre. 
Affichez a nouveau le spectre réduit final. Le logiciel à maintenant « calibré » l'axe des abscisses en 
longueur d'onde. Vous pouvez maintenant sauvegarder le spectre final réduit et calibré en cliquant sur 
File > Save et en entrant un nom de fichier comme 
. Vous pouvez également sauvegardé le résultat de la fenêtre d'affichage en cliquant sur l'icône 
JPEG/PNG situé en haut de cette fenêtre qui sera sauvegardé sous le nom . 

7. Identification de raies 
Pour finir, vous pouvez essayer d'identifier quelques raies typiques de ce type d'étoiles. Commencer 
par identifier les régions du spectre utilisables. Que pouvez-vous dire des régions λ < 4770 Å, λ > 
5245 Å et λ ~ 4940 Å ? 
Quelle est l'origine de la raie la plus intense/large ? Identifiez d'autres éléments en vous aidant du 
catalogue de Coluzzi et al. disponible sur Vizier (http://vizier.u-strasbg.fr/viz- bin/VizieR): recherchez le 
mot-clé « Coluzzi » puis sélectionnez le catalogue illss. Cherchez dans ce catalogue les éléments 
présents dans les étoiles de même type spectral entre ~ 4800 et 5300 Å. Pour simplifier, on pourra 
d'abord rechercher le type spectral exact de cette étoile (HD196379) à partir de la base de données 
Simbad (http://simbad.u-strasbg.fr/simbad/) pour ensuite chercher les raies correspondantes. 
Pendant le stage OHP, nous chercherons à observer au T152 plusieurs étoiles de type spectral 
différent pour comprendre la relation entre les propriétés fondamentales des étoiles (métallicité, 
gravité, température) et la morphologie des raies spectrales (largeur, intensité, etc.). 


